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Preface 

Thank you for purchasing an Autonics product. 

This user manual contains information about the product and its proper use, and should be kept 
in a place where it will be easy to access. 
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User Manual Guide 

This user manual contains information about the product and its proper use, and should be kept 
in a place where it will be easy to access. 

 Please familiarize yourself with the information in this manual before using the 
product. 

 This manual provides detailed information on the product's features. It does not offer 
any guarantee concerning matters beyond the scope of this manual. 

 This manual may not be edited or reproduced in either part or whole without 
permission. 

 A user manual is not provided as part of the product package.                  
Visit www.autonics.com to download a copy. 

 The manual's content may vary depending on changes to the product's software and 
other unforeseen developments within Autonics, and is subject to change without 
prior notice. 

 This manual is produced based on DAQMaster 2.6.0 version. 
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User Manual Symbols 

Symbol Description 

 
Supplementary information for a particular feature. 

 
Failure to follow instructions can result in serious injury or death. 

 
Failure to follow instructions can lead to a minor injury or product damage. 

 
An example of the concerned feature's use. 

※1 Annotation mark. 
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1 DAQMaster Overview 

1.1 Overview 

DAQMaster is a comprehensive device management program that can be used with Autonics 
communication supporting products. 

DAQMaster provides GUI control for easy and convenient management of parameters and 
multiple device data monitoring. 
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1.2 Features 

(1) DAQMaster Pro Version Feature 

 Data Base 

Database managing system (Access, MySQL, SQL Server, Oracle, SQLite) turns 

information into database in real-time, making creation and management of database 

easier. 

 Real-time Logging 

At the set cycle and condition, real-time log file is generated in CSV file. 

 Modbus Device Editor 

You can add the any modbus devices which are not supported at DAQMaster to set 

and monitor the property and I/O. 

 OPC Client 

It is Interface method for better compatibility among application programs based on 

OLE/COM and DCOM technology of Microsoft. It provides industry standard 

mechanism for communication and data conversion between client and server. 

 DDE Client 

It supports communication (IPC) among process embedded in Microsoft Window 

system, allowing application programs to share and exchange information. This 

function uses shared memory and provides a common protocol (instruction set and 

message format) to application programs. 

(2) Featurs 

 Multiple Device Support 

Simultaneously monitor multiple devices and set parameters. Simultaneously connect 

units with different addresses in a single device. Multiple RS-232 ports are available for 

communications using Modbus remote terminal unit. 

 Device Scan 

In cases of multiple units (with different addresses) connected together, the unit scan 

function automatically searches for units. 

 Convenient User Interface 

Freely arrange windows for data monitoring, properties, and projects. Saving a project 

also saves the screen layout. 

 Project Management 

Saving data as a project file includes added device information, data monitoring screen 

layouts, and I/O source selection. When you open the project file, the last state of the 

saving moment will be loaded. Organizing project list makes managing project files 

easier. 

 Data Analysis 
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Performs grid and graph analyses of data files (*.ddf ) using data analysis feature of 

DAQMaster. Saves grid data in .rtf, .txt, .html, or .csv files in Data Grid. 

 Monitoring Data Log 

When monitoring, data log files can be saved in either DAQMaster data files (.ddf) or 

CSV (.csv) files. Open files saved in .csv format directly from Microsoft Excel. Define 

log data file naming/saving rules and destination folders to make file management 

convenient. 

 Tag Calculation Editing 

Read tag value is available to calculate the set formula for the desired value. 

 Print Modbus Map Table Report 

Print address map reports of registered Modbus devices. Modbus map table reports 

can be saved in html (*.html) and pdf (*.pdf) formats. 

 Multilingual Support 

Supports Korean, English, Japanese, and Simplified Chinese. To add a different 

language, modify the files in the Lang folder rename, and save. 

 Script Support 

Uses the Lua Script language and deals with different I/O processes for individual 

devices. 
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1.3 DAQMaster Funtion Comparison Table by Version 

Functions General version Pro version 

Modifying parameter ○ ○ 

Data monitoring ○ ○ 

Data log ○ ○ 

Tag calculation editing ○ ○ 

Trigger Ⅹ ○ 

Data analysis ○ ○ 

Analysis spread Ⅹ ○ 

User Modbus Device Editor Ⅹ ○ 

Script Ecitor Ⅹ ○ 

Database Device Ⅹ ○ 

DDE Server Ⅹ ○ 

TCP/IP Server Ⅹ ○ 

DDE Client Ⅹ ○ 

OPC Client Ⅹ ○ 

WMI Manager Ⅹ ○ 

Realtime Log (CSV) ○ ○ 

Realtime Log (DB) Ⅹ ○ 

SQL Server Ⅹ ○ 

Oracle Ⅹ ○ 

MySQL Ⅹ ○ 

PostgreSQL Ⅹ ○ 

SQLite Ⅹ ○ 

Nexus DB Ⅹ ○ 

Inter Base Ⅹ ○ 

Firebird Ⅹ ○ 

ODBC Ⅹ ○ 

MS Access Ⅹ ○ 

Sybase ASE Ⅹ ○ 

Sybase ADS Ⅹ ○ 

DB2 Ⅹ ○ 

DBF Ⅹ ○ 
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2 Installing the Program 

2.1 System Requirements 

Item Minimum specifications 

System IBM PC compatible computer with Intel Pentium Ⅲ or above 

Operations Windows 98/NT/XP/Vista/7/8/10 

Memory 256 MB+ 

Hard disk 1GB+ of available hard disk space 

VGA Resolution: 1024×768 or higher 

Others RS232C serial port (9-pin), USB port 

2.2 Preparations 

1st Download DAQMaster program at Autonics’ web page(www.autonics.com).  

2nd Close all programs before you start DAQMaster installation. 

Double-click DAQMaster setup.exe to start installation. 

3rd Installer Language window appears. Select the language and click OK button. 

DAQMaster supports English, Japanese, Korean and Simplified Chinese. 
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4th Click Next in the installation welcome window. 

 

5th Choose Install Location window appears. Default installation path is C:\Program Files 

(x86)\DAQMaster. 

 

 

 

 

 

 

 

 



  2 Installing the Program 

©  Copyright Reserved Autonics Co., Ltd.  19 

6th Click Install button to choose the default path for installation. Click Browse button to 

change the installation path. In the Browse Folder window, select the desired 

destination folder and then click OK to start installation. 

 

7th Installation progress is displayed in the status window as follows. 
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8th Installation Complete window appears after installation is completed. 

If the check box in the Installation Complete window is checked, DAQMaster runs 

upon completion of installation. You can now run DAQMaster by double-clicking the 

DAQMaster icon on the desktop. 

 

When running the program for the first time, the initial screen displays the following.
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2.2.1 Register License 

When installing DAQMaster, it provides pro demo version.  

After finishing demo period (30 days), pro functions are inactive. Only general version is 
available.  

After registering license, pro functions are available: DDE Server, Edit ModBus Device, TCP/IP 
Server, Script Editor, Trigger, Realtime Log, Miscellaneous (Database, DDE Client, OPC Client, 
WMI Manager) and analysis spread of data analysis. 

For purchasing licenses, contact the retailers by referring the web site (www.autonics.com). 

(1) Entering license 

1st Enter Help > License menu.  

 

2nd At License, click ‘Request Serial Number’.  

  

Enter user information (last name, family name, company, etc.) and click ‘Save 

clipboard’. Based on this information, ask the serial number and register code to the 

retailer.  

 

3rd Enter the provided serial number and register code. 

http://www.autonics.com/
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4th When click ‘Register’, the program will be registered as pro version and be able to 

use pro functions continuously.  

 
The registered Pro version displays the registered number of licenses and tag limit.  

After registering Pro version, ‘Register’ button turns into ‘Upgrade’ button. When you enter 

new serial number, registered number of licenses and tag limit are changed, corresponding    
to new serial number. 

(2) Connecting USB dongle 

Plug the USB dongle for DAQMaster Pro license to your PC and run the DAQMaster Pro. 
The license key is installed automatically. (it may take some time.) 

 

You can check the serial number,(the number of) tag limit, and (the number of) client at USB 
Dongle of “Help>License” at Help menu,  

 

2.2.2 Installation Folder Structure 

This section explains the folder structure created when you installed DAQMaster. 

After DAQMaster installs completely, folders are created as below. The program and all relevant 
documents are stored in these folders. 

If you selecte the default installation path during installation, a DAQMaster folder is created 
under [C:\Program Files] as a subfolder. If you selecte a new destination folder, DAQMaster 
folder is located in that folder. 
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(1) Device folder 

Device folder contains the device information files (*.dev), which can be monitored and set 
with DAQMaster. When the program is executed, the files in this folder automatically add 
related devices to the program. 
If devices are added or upgraded after the program is installed, copy the device information 
file and put it into this folder. The list of available devices will be updated. However, if a 
communication related function is added or modified, it also changes the contents of the 
[plug-in] folder. Therefore changes may or may not be applied depending on the level of 
upgrade. 

(2) Lang folder 

The language information files (*.lang) available in this program are contained here. The 
program reads all files in the folder and automatically adds them to the program when it runs. 
The language information files are written in a text file format, so you can modify and add 
text using XML Notepad. Korean, English, Japanese, Simplified Chinese language files are 
in this folder by default. 

(3) Plug-in folder 

This folder contains core library files (*.dll) for ModBus communications as well as runtime 
screen files (*.rpu). The [prop] folder under the [plug-in] folder stores library files that have 
special functions for each specific device. 
 

 

2.2.3 Uninstalling the Program 

There are procedures to uninstall DAQMaster. Select Start > Program > DAQMaster > Uninstall 
or Start > Setting > Control Panel > Add/Remove a Program > DAQMaster. 

If you select Remove, a confirmation window will appear. Click Yes to remove DAQMaster from 
the computer. 

2.3 Start and Exit 

2.3.1 Start 

Double-click DAQMaster on the desktop or select Start > Program > DAQMaster to start 
DAQMaster.  

2.3.2 Exit 

Click X button on the top right corner of the screen to end the program. 

Projects are not saved automatically. Please make sure you save the project before you exit. 

.  



2 Installing the Program   

24  ©  Copyright Reserved Autonics Co., Ltd. 

 

 

 

2.4 DAQMaster Screen Layout 

 

The program screen is divided into sections as shown in the preceding screenshot and each 
section is composed of the following items. 

NO. Item Description 

1 Menu 
Displays DAQMaster menus by category. If you select a 
menu, submenus appear. 

2 Project List 
Displays recent projects or usually used project list to 
manage the files.  

3 Support Device List Displays a list of devices supported by DAQMaster. 

4 I/O List Displays parameter items of devices added to My System. 

5 Project Shows the basic information of the current project. 

6 My System 
Shows list and connection status of devices connected to 
DAQMaster. 

7 DAQ List Shows added parameter items in I/O List. 

8 Message 
Records events.  
It displays communication connection and disconnection, 
errors.  

9 DAQ WorkSpace Displays added UI items in RunTime Screen. 

10 Property 
Allows checking and modification of information for items in 
Project, My System, DAQ List and setting unit parameters. 

11 Run Time Screen Displays screen library for data monitoring. 
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2.4.1 Menu 

(1) Project 

 

1) File 

 New: Creates a new project. 

 Open From List: Opens a project from the project list. 

 Open Project: Opens a saved project. 

 Save: Saves the project you are working on. 

 Save As: Saves the project as a file name. 

2) Run 

 Connect/Disconnect: Connects or disconnects the device and communication. 

 Run/Stop: Starts or stops monitoring data in the connected devices. 

 Log/Stop logging: Saves or stops logging currently monitored data. 

 View Log: Views log data during logging. You can check data between Log running 
point and View Log executing point. 

(2) View 

 
3) View  

 Tool: Set for Property, Support Device List, My System, Project, I/O List, Run Time 
Screen, DAQ List, Message of the project.  

 Language: Changes the program language. 

4) Windows 
Aligns multiple runtime screens (Data: Grid, Multi Panel, Panel, Line Graph, Bar 
Graph, Color Map Graph, Gauge Graph, Histogram Graph, Device: Alarm History 
Grid) diagonally, horizontally, and vertically. 
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5) Layout 
Executes saving, deleting, loading layout. You can select the saved layout at User 
Layout.  

 

 Default: Changes docking screen layout to default layout.  

 Runtime: Displays only run time screen. Select the hidden docking screen at View 
menu.  

 Save Layout: Saves the current layout and adds it at User Layout.  

 

 Delete Layout: Select the saved layout and delete it.  

 

(3) Tool 

 
 Time Display: Displays monitoring time.  

 Data Analysis: Runs the data analysis program. Allows analysis of DAQMaster data file 
(*.ddf). 

 DDE Server: Runs DDE Server setting. 

 Edit ModBus Device: Executes Modbus Editor. 

 TCP/IP Server: Operates DAQMaster as a TCP/IP Server. 

 Script Editor: Runs Script Decive Editor 
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(4) Help 

 
 Help: Opens the help file. 

 Check Update: Checks the version of the program via the internet update server and 
automatically updates to the latest version. 

 License: Registers and checks license.  

 About: Checks the DAQMaster version. 
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2.4.2 Support Device List (Docking Screen) 

Support Device List shows list of devices supported by DAQMaster. The Support Device List will 
be updated continuously. 
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2.4.3 Project 

Project saves runtime screen information and I/O source. Allows you to work in previously used 
environments again. In Property at the right side of the screen, you can change general 
information, data file, log data schedule, and project opening option. For more information, refer 
to '2.4.9 Property'. 

  

2.4.4 I/O List (Docking Screen) 

I/O List shows parameters entries you can monitor for devices added to My System. I/O List 
appears depending on connected devices. 

To monitor units of the connected device, you have to list desired sources from I/O List to the 
DAQ List. Searching function is available.  

Added sources are shown in gray. 

 

 

I/O source cannot be added to DAQ List when the Status is Run. 
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2.4.5 My System 

My System displays devices and units added from the device list in a tree structure. You can also 
check and configure connection status. 

You can add, change or delete devices and units (addresses) in My System. 

 

 RS-232: Allows property modification related to RS-232 communications in Property when 

devices are disconnected. 

 ModBus Master: Allows property modification related to ModBus Master protocol in Property 

when devices are disconnected (mode and the number of re-try are displayed).  

 Device (TK4): Allows you to see connected device information. 

 Unit (1): Allows read and write of parameters as well as check the reading process while 

devices are connected. 

Connects a device to multiple communications ports as displayed in following image. 
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2.4.6 DAQ List 

DAQ List is a list of I/O sources that will be communicated. 

the number of I/O sources is displayed by signal type in the left list. When one of signal type is 
selected, I/O sources in right list is rearranged by signal type. 

 

You can search the desired tag (standard or user) at the right-top of the DAQList.   

 

 

Elements of the DAQ List cannot be added to a runtime screen when the Status is Run. 

2.4.7 Message 

Records events (communication status (start/stop communication, error), log status (start/stop 
log), etc.) during running the program.  

 

Messages are saved as *.txt file or log file. Log file is reside in ‘Message’ folder in the installation 
folder. 
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2.4.8 DAQ WorkSpace 

Displays added UI screen (Data: Grid, Multi Panel, Panel, Line Graph, Bar Graph, Color Map 
Graph, Gauge Graph, Histogram Graph, Device: Alarm History Grid) in RunTime Screen. 

 

To add or delete DAQ WorkSpace or change DAQ WorkSpace name, click “DAQ Space” of DAQ 
Space screen.  

 

Click pull-down icon (▼) on the upper right of DAQ WorkSpace to select the activated space.  
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The name of the DAQ WorkSpace is changed to ‘Gauge and Color’, and ‘Graph’ space is added. 
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2.4.9 Property 

The Property window allows item checking and modification of Project, My System and DAQ List. 

There are check-only items and modifiable items. Modifiable items are displayed as edit type, 
combo box type, run type and mixed edit/combo type. 

(1) Edit type 

 
Enter number or text in the blank. Input range (if applicable) is displayed at the bottom. 

(2) Combo box type 

 
Click the combo button on the right to see a list of items to select. 

(3) Run type 

 
Click [...] button on the right to start the relevant function. 

 

(4) Mixed edit-combo type 

 
Enter numbet or text in the blank (within the range specified at the bottom) and select a 
value from the list. Items out of range can only be selected from the combo box list. 
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2.4.9.1 Project Properties 

Clicking Project Name (default: Noname) allows you to set and enter General (project name, 
company, worker, description), Data file (data folder, data file creation rules, CSV time type, etc.), 
Log data schedule (log data schedule, active schedule), and Project opening option (run mode, 
layout). 

     

(1) General  

You can enter project name, company, worker, description for project management.  

(2) Data File 

You can designate log data automatic saving options: the folder to save, creation rule of 
data file, and time type of CSV..  
Log data is available to save as *.csv or *.ddf file type.  
 Data Folder: Designates the folder to save project data.  
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 Data File Creation Rules: Designates creation rule of data file.  

 

 CSV Time Type: Sets CSV time type.  

 

 

 Realtime log: At the set cycle and condition, logging starts in real-time. It is available to 
set each I/O. This function is only for DAQMaster Pro version.  

When you click "Data File> Realtime Log[...]" at Project Property window, ‘Realtime 
Log’ dialog box appears. Click ‘Add’ button executes ‘Log Editor’.  

 

In the ‘Log Editor’ dialog box, you can set ‘Save Type’ of the real-time log file.  
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- When setting save type as ‘Database’,  
Set log name, saving condition, and saving interval.  

Saving conditions are following.  

Condition Description 

Periodic Auto Save  

(No Condition)  No condition.  

Equal  
When selected tag value is equal to the set value, logging 
starts. 

Less Than  
When selected tag value is less than the set value, logging 
starts. 

Greater Than  
When selected tag value is greater than the set value, 
logging starts. 

Equal or Less than  
When selected tag value is equal or less than the set value, 
logging starts. 

Equal or Greater 
than  

When selected tag value is equal or greater than the set 
value, logging starts. 

Not Equal  
When selected tag value is not equal as the set value, 
logging starts. 

Rising Edge  When selected tag value is rising edge, logging starts.  

Falling Edge  When selected tag value is falling edge, logging starts. 

In Information box, set ‘Database Connection Info’ and ‘Table Columns Info’.  

‘Table Columns Info’ is actiaved after setting ‘Database Connection Info’. 

 

 

 

 



2 Installing the Program   

38  ©  Copyright Reserved Autonics Co., Ltd. 

1st Click ‘Database Connection Info’ [...] button and ‘Database Settings’ dialog box 

appears. Set provider, server, port, user name, password and database.  

It can access to various data base and provides I/O function.  

 

2nd After entering information, click [Next] and ‘Database Table Settings’ appears.  

Select the desired table or add the new table. Click ‘Next’.  
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3rd At ‘Database Time Field Settings’, select save type and time field.  
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4th Check the data base file and click ‘OK’.  

 

5th After completing the setting, Log Editor dialog displays the set database connection 

information. Table Columns Info [...] button is actiaved.  

 

At ‘Table Columns Info’, it is available to check and edit elements: field, type, tag type, 

tag name 
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- When setting save type as ‘CSV File’,  

Set log name, saving condition, saving interval.  

Saving conditions are following.  

Condition Description 

Periodic Auto Save  

(No Condition)  No condition.  

Equal  
When selected tag value is equal to the set value, logging 
starts. 

Less Than  
When selected tag value is less than the set value, logging 
starts. 

Greater Than  
When selected tag value is greater than the set value, 
logging starts. 

Equal or Less than  
When selected tag value is equal or less than the set value, 
logging starts. 

Equal or Greater 
than  

When selected tag value is equal or greater than the set 
value, logging starts. 

Not Equal  
When selected tag value is not equal as the set value, 
logging starts. 

Rising Edge  When selected tag value is rising edge, logging starts.  

Falling Edge  When selected tag value is falling edge, logging starts. 

In Information box, set ‘File Path Information’ and ‘Tag List Information’ . 
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1st Click ‘File Path Information’ [...] button and ‘CSV Log Editor’ dialog box appears. Set 

file path settings: folder, file name, file name rule 

 

2nd Click ‘Tag List Information’ [...] button and ‘CSV Log Editor’ dialog box appears. Set 

tag list settings.  

 

3rd Click ‘Add’ and DAQ Tag List is appears. Add tags.  
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4th If logging need to be started when executing DAQMaster, check ‘Logging’ at Log 

Editor dialog box.  

When checking ‘Logging’, the file (*.prx) is created at the set file path and logging 

starts.  
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(3) Log Data Schedule 

Saves log data at the scheduled time automatically.  
 Log Data Schedule: Sets log data saving time.  

 

No Description 

1 Adds log data schedule items.  

2 

Displays scheduled log data items.  

You can delete the scheduled item by checking the left check box and clicking 3. 
‘Delete’ button. 

3 Saves or deletes the set items.  

4 
Designates log data name.  

The file name of data file creation rule is displayed next to the data name.  

5 Designates start time.  

6 Designates end time.  

7 

Designates split save time.  

When you set 1 hour 30 minutues, it saves the file for 1 hour 30 min. and creates 
another file and saves it.   

8 Designates repetition day of week.  

9 Checks log data schedule items.  

 Active Schedule: Designates whether to activate log data schedule.  

(4) When Opening Project  

 Run Mode: Sets runing mode when opening the saved project file.   

 Layout : Designates the screen layout (default, runtime, current layout) when opening 
the project.  
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2.4.9.2 My System Properties 

(1) RS-232 

Click RS-232 in My System to modify Name in RS-232 general properties. 

 
You can also modify Search Port List, Communication Port, Baudrate, Check Parity, Stop Bit, 
Per Byte, Hardware, Software, DTR Control, and RTS Flow Control in Configuration. 

(2) Modbus Master 

You can modify Name in ModBus Master general properties by clicking ModBus Master in 
My System. You can also modify Mode and Timeout in Configuration. 

 

(3) Device (TK4)  

Click a device (TK4) in My System to see basic device information in the Property window. 
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(4) Address (1) 

Click the device address (1) in My System to see detailed device information. 
You can also change Device Name and set DAQ Repeat Interval. 

 
You can check and modify device parameters by reading parameters while devices are 
connected. 

2.4.9.3 DAQ List Properties 

(1) General  

If you select items that were added from I/O List for communication, the Property window 
displays item information. You can change Tag Name, Decimal Point, Unit, and Scrept 
variables in General proporties and edit Tag value formulas in I/O Data Calculation. 
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(2) I/O Data Calculation 

You can edit tag values at “Property > I/O Data Calculation > Edit Calculation”. When 
reading the tag value via editing calcuation at DAQMaster, you can get the desired data by 
applying the calcuation at data. ‘x’ means the output tag value from device. This function 
displays the calcuated output value at DAQMaster.  

 
Click ‘Templete’ at the top-right of the dialog to edit and save the usually used calculations. 
It is useful to apply read/write calcuation directly.  

 
Enter the desired formular and click the ‘Save’ and ‘Apply’.  
The saved template is applied the ‘Edit Calculation’ dialog box.  
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(3) Trigger 

In “Property > Trigger > Conditions […] ”, you can set Trigger event executing conditions. When 
Tag velue matches the conditions, Triger event is activated as your setting.  

 

 Trigger Management 

Management Description 

Trigger list Displays the saved triggers as list.  

Add trigger  
Adds a trigger on the trigger list.   

You can set trigger name, conditions, etc.  

Save trigger  Saves the added trigger at the trigger list.  

Delete trigger  Delete the selected trigger on the trigger list.  

Delete all triggers  Delete all triggers on the trigger list. 

 Trigger conditions 

Conditions Description 

Periodic Auto 
Save  

(No Condition) 
 No condition.  

Equal  When selected tag value is equal to the set value, trigger starts. 

Less Than  When selected tag value is less than the set value, trigger starts. 

Greater Than  When selected tag value is greater than the set value, trigger  starts. 

Equal or Less 
than  

When selected tag value is equal or less than the set value, trigger 
starts. 

Equal or Greater 
than  

When selected tag value is equal or greater than the set value, trigger 
starts. 

Not Equal  When selected tag value is not equal as the set value, trigger starts. 

Rising Edge  When rising edge signal is input, trigger starts.  

Falling Edge  When falling edge signal is input, trigger starts. 

Static Maintain  When the value is maintained during the set time, trigger starts.  

 Check Time 

When the set trigger condition is satisfied during the set check time, trigger starts.  
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 Event 

Condition Description 

Log Start When tag value maches the set condition, logging stars. 

Log Stop When tag value maches the set condition, logging stops. 

Send to Telegram  
When tag value maches the set condition, Telegram message is sent 
to the designated person. 

Alam sound play 

When tag value maches the set condition, alam sound is played. You 
can select audio file you want. 

(supported audio file format: *.mp3, *.mp2, *.wav, *.ogg) 

Tag Error Message 
When the trigger condition is satisfied, the run time list data cell color 
of this tag is changed. Data value is displayed as ‘Tag error’ and it is 
displayed same as log file.  

Tag Alarm 
When the trigger condition is satisfied, the run time list data cell color 
of this tag is changed. Data value is displayed as the actual data 
value.  

※1. Telegram setting 

Telegram is a nonprofit open source internet messanger, available in diverse operating system 
such as Android, IOS, Window, MAC and Linux. It provides users with source code, encouraging 
them to develop desired funtions with the messanger. 

By the Bot, virtual conversation contact, when tag value maches the set condition, Telegram 
message is sent to the designated person. (Internet connection is required.) 

By telegram functions, you can share the massage to the other groups and search the 
messages. Please refer to the telegram usage. (Android and IOS system have a identical setting 
process. This manual explains with Android) 

1st Search “Telegram” at the Andriod Play store and download the application. 

2nd You have to creat and register a virtual robot called Bot to receive messages from 

DAQMaster. 

In contats of Telegram, search and select @Botfather at the upper the magnifying 

glass icon.  
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3rd Click ‘Start’ at the below button of the display.  

 

4th Enter ‘/newbot’ in the message box to creat your own Bot. 

According to the BotFather message, name a Bot name, Bot user name (must end in 

‘bot’ or ‘Bot’).  

Bot user name is for identifying name at the telegram. It must end in ‘bot’ or ‘Bot’. If 

the other named the designated name already, it is not used in duplicate.   

(E.g. Bot name: Autonics, user name:at_androido_autonicsbot ) 

  

  



2 Installing the Program   

52  ©  Copyright Reserved Autonics Co., Ltd. 

5th Then you are provided with address to chat with the created Bot and token to connect 

your Bot and DAQMaster. 

Click the given address to join chat with the Bot. 

 

6th Click ‘Start’ at the button of the display. 

One or two times of free conversation are necessary prior to receiving message from 

your Bot.  

If you send the messages, the group may be not searched.  
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7th At DAQMaster, select the I/O to apply trigger and click “Property > Trigger > 

Conditions […] ” and ‘Tag Trigger Event’ dialog box appears. Add trigger and enter 

condition/value and select Event as ‘Send to Telegram’. Telegram settings are 

available.  

8th Go back to the DAQMaster, enter the token of 5th step in the token blank in Tag 

Trigger Event dialog. Click ‘Search Groups’. 

 

9th You can see user name of chat relevent to the token. 
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10th Check the desired receiver and select chat to use and choose alam message format 

among time, tag name, and condition. 

After enter test message in the bottom blank, click ‘Save and Test’ button. 

 

11th You can receive test message in Telegram 

 

12th Telegram message setting is completed. 

When tag value maches the set condition, Telegram message is sent. 
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2.4.9.4 Runtime Properties  

You can desigante added runtime screen (Data: Grid, Multi Panel, Panel, Line Graph, Bar Graph, 
Color Map Graph, Gauge Graph, Histogram Graph, Device: Alarm History Grid) name, update 
interval, and the others.  

You can modify the name of the Grid in Run UI general properties by clicking Grid at Runtime 
Screen in Project dialog. You can also modify Update Interval time in Config. (Default: 1,000 ms.) 
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2.5 Runtime Screen Library 

Double-click UI item in Runtime Screen Library and the item is added in DAQ WorkSpace.  

 

 

Runtime Screen Library is a list of runtime screens for data monitoring. 

Runtime screens support Data: Grid, Multi Panel, Panel, Line Graph, Bar Graph, Color Map 
Graph and Gauage Graph, Histogram Graph, Device: Alarm History Grid. You can open multiple 
screens at the same time for monitoring. Information such as screen position, screen size and 
I/O source is saved when saving the project. 
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2.5.1 Data 

(1) Grid  

 

(2) Multi panel 

 

(3) Panel 
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(4) Line Graph 

 

(5) Bar Graph 

 

(6) Color Map Graph 
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(7) Gauge Graph 

    
 

 

(8) Histogram Graph 
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2.5.2 Alarm 

(1) Alarm History Grid 
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3 Getting Started 

On a default layout screen, you generally work from left to right. 

 

The basic work order is as follows: 

1st Select a device from the Support Device List in the very left side of the screen and 

add it to My System. 

2nd Select a device from My System and add a relevant unit (address). 

3rd From the very left I/O List, add I/O items for monitoring to DAQ List at the bottom. 

4th Select a monitoring screen from Runtime Screen library in the very right side of the 

screen. 

5th Drag an I/O source from DAQ List and drop it onto the Runtime Screen. 

6th Configure RS-232 or Modbus TCP environment. 

7th Connect (you can read and set the device parameters). 

8th Run (data file logging is available). 
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3.1 Support Device List - Selecting a Device 

For example: TK4 (Address 4) is connected to RS-232 Port 1. 

First, select the device to communicate with from the Supported Device List. The Support Device 
List (docking screen) is a list of devices supported by DAQMaster. You can only communicate 
with listed devices.(The Support Device List will be updated continuously). 

Below is the example screen for the currently supported devices(as of Fabruary, 2017).  

Type Series/Model name Function 

Autonics 

  
ARM Modbus Digital Remote I/O  

 
BFC  Digital Display, Fiber Optic Amplifier 

 
CT  Programmable Counter (Timer) 

 
DS(A)-xT Intelligent Display Unit 

 
DS-RRT Intelligent Display Unit 

   
MP5 Pulse Meter (Modbus RTU) 

 
MP5W Pulse Meter   

 
MP5Y Pulse Meter 

 
MT4 Multi Panel Meter 

 
SCM-USU2I 2-CH USB Temperature Data Logger 

 
SCM-WF48 SCM-WF48 Configuration 

 
TF3 Refrigeration Temperature Controller 

 
THD Temperature/Humidity Sensor 

 
TK4 General-Purpose Temperature Controller 

 
TM2 2-CH Modular Type Temperature Controller 

 
TM4 4-CH Modular Type Temperature Controller 

 
TX LCD Display Temperature Controller 

 
TZ/TZN Dual PID Control Temperature Controller 

Miscellaneous 

 
Database Database 

 
DDE Client DDE Client 

  
OPC Client OPC Client 
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Type Series/Model name Function 

 
WMI Manager WMI Manager 

Process 
Automation 

 
DPU (1-Phase) Thyristor Unit 

 
DPU (3-Phase) Thyristor Unit 

 
KN-2000W-D2 Multi Input Indicator 

 
KPN Digital Process Controllers 

 
KRN50 50mm Hybrid Recorder 

 
KRN100 100mm Hybrid Recorder 

 
KRN1000 LCD Touchscreen Paperless Recorder 

Devices made in Script Editor 

When a device is selected, you can see basic information about the device in Property window 
as follows. 

 

If you click or double-click the device expand button (+) in the Support Device List, the spesific 
list of support device will appear. 
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Select the device you want to add to My System (Temperature Controller TK4). Double-click or 
mouse right-click the selected device and click Add to My System to add the device. 

 

 Refresh: Updates Support Device List when device files (*.dev) are added. 

 Add to my system: Adds device to My System to communicate. 

 Expand all: Shows the list of all supported devices. 

 Collapse all: Hides the list of all supported devices. 

Double-click RS-232 or TCP/IP on the new DAQ interface, or select it and click OK.  

(TK4 supports RS-232 communication and it displays only RS-232.) 

You can modify the configuration of the added RS 232 or TCP/IP in properties. 

 

If there is another devices added earlier, you can see added RS-232-COM1 on the Added DAQ 
Interface. 
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3.2 Setting RS-232, TCP/IP 

3.2.1 RS-232C 

Set up RS-232 for communication. Select RS-232 in My System and check Property window. 

  

Property window displays information about the communication port currently in use. 

If you want to change the name in My System, modify Name in Property window. 

The Config items are following. 

Item Description 

Search 
Port List 

Fix Init List 
Loads communication port list of computer at the point when  
RS-232 is added, saves it to the Port List and then fixes it. 

Auto 
Search 

Rearranges Port list, if the port list of computer (such as USB 232) 
is changed. 

Communication Port 
Shows choice of connectable COM Ports. 
You can designate the connected COM Port.  

Baudrate 1,200, 2,400, 4,800, 9,600, 19,200, 38,400, 57,600, 115,200 bps 

Check Parity 
Allows communication parity selection. (none, odd, even, mark, 
space) 

Stop Bit Selects Stop Bits. (1, 1.5, 2) 

Bit Per Byte Selects Byte Size. (5, 6, 7, 8) 

Hardware None, RTS/CTS 

Software None, XON/XOFF 

DTR Control Disable, enable, handshake 

RTS Flow Control Disable, enable, handshake, toggle 
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3.2.2 TCP/IP 

Set up TCP/IP for communication. Select TCP/IP in My System and check Property window. 

   

Property window displays information about the communication port currently in use. 

If you want to change the name in My System, modify Name in Property window. 

The Config items are following. 

Item Description 

Socket 
Type 

Client Sets as client mode (when connecting KRN100) 

Server Sets as server mode.  

Address Enters the designated IP Address from the main device.  

Port Sets port number. 

Connection Timeout Sets Connection Timeout 

Client Type 
Non Blocking 

After transmission, next transmission is available regardless 
of response. 

Blocking 
After transmission, next transmission is available after 
receving response. 

Auto 
Connection 
Mode 

Use Uses auto connection mode.  

Not used Not use auto connection mode.  

At ModBus Master property, set Mode of Config as ModBus TCP.   
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3.3 Adding a Unit to My System 

My System displays device and communication interfaces added from the Support Device List in 
a tree structure. It also displays connection status, and you can add, change and delete device 
units (addresses). 

By selecting an item, you can set or modify it in Property window. 

 

Selecting TK4 device enables Add button. To add a unit(address), click the Add button on the tab 
or right-click on mouse to select Add. 
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Select address (number 1) set to TK4 device. Double-click or use ‘>’ button to add, then click OK 
button. 

 

 

 

You will see the unit (address: 1) added under the device in My System. If you want add same 
type of multiple devices, click Add button. (Up to 99 devices can be added.)  
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Selecting the unit address (1) activate Change button. To change the unit address, click the 
Change button on the tab or right-click on mouse to select Change.  

 

If you click Change button, the current address (1) highlights in yellow. Select a new address 
and click OK to change the unit address. 

  

 

Unit (address) cannot be deleted, changed or added while the Status is Connect. 
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3.4 Scan Unit 

Scan Unit feature scans multiple connected device units. You can check the detected units and 
add them to My System by using this feature. 

1st Add TK4 device and configure RS-232 environment as below. And then connect. 

 

2nd When connected, select TK4 device, and right-click to select Scan Unit Address. 

  

3rd If you select Scan Unit Address menu, the following Scan Unit dialog appears. 
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4th Set an address range to scan and click Start Scan button to scan units automatically. 

Scanned units are listed on the left side. Other scanned units are listed on the right 

side. 

  

 

 

5th Check a unit to add from the list and click OK. It is added and marked as Connected. 
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3.5 Adding an I/O to the I/O List 

I/O sources are used to read and control data. To monitor a source listed in the I/O List, you 
must add the source to DAQ List. 

I/O List shows which units are added to My System. If you click expand button (+), it displays a 
list of available I/O sources to add. You can search the desired I/O and add it.  
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Double-click or right-click sources you want to communicate, and select Add to DAQ List. 

   

I/O sources are added to DAQ List as below. 

 

 

I/O source cannot be added to DAQ List when the Status is Run. 

To delete added source in DAQ List, select and right-click the source. If you select a source or 
sources you want to delete and right-click on mouse, a pop-up menu will appear as below. Then 
click ‘Delete the selected item(s)’, ‘Remove all’ or ‘Select All’ to delete. 
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Sources added to DAQ List are grayed out in the I/O List. The image below shows that Present 
Value, Set Value, Heater Current Monitoring, OUT1 Lamp, OUT2 Lamp, AL1 Lamp, and AL2 
Lamp are added to DAQ List. 
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3.6 DAQ List 

DAQ List shows a list of sources added from I/O List. 

  

To add I/O sources in the DAQ List to the runtime screen, select the sources to add, then drag 
and drop them onto the botton of the runtime screen. Make sure to place the mouse cursor on 
the text of the source when selecting a source to drag and drop.  

You can select a source in the DAQ List and check/modify it in Property window. 

  

General items of Property is as below.  

 Device: Device name 

 Address: Unit address 

 Source: I/O source name 

 Tag name: Saves tag name as 'address_I/O source name' and is changeable. 

 Decimal point: Changes the decimal point of data. 

 Unit: Allows you to change the unit of data. 

 Script Variable: Tag value 

 Description: Allows you to enter the description. (Read/write mode) 

I/O Data Calcualation items of Property is as below.  

 Edit Calcuation: When reading tag value, apply the data formular to get the desired 
data.  

 

For certain I/O sources, decimal point and unit will be set automatically. In this case, they 
conform to the parameter set values. 
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3.7 Adding from DAQ List to Runtime Screen Library 

Runtime screens monitor data and support 4 types of screen, Data: Grid, Multi Panel, Panel, 
Line Graph, Bar Graph, Color Map Graph, Gauge Graph, and Histogram Graph, Alarm: Alarm 
History Grid. You can search the desired runtime screen and select it. Runtime screens can be 
set and added according to the user environment. If an error occurs while adding Panel to 
Runtime Screen Library, install Adobe Flash Player. 

  

To add a runtime screen from runtime screen library, double-click the type as required. 

Below is an example of runtime screen display. (Grid, Multi Panel, Line Graph are applied.) 
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3.7.1  Data 

3.7.1.1 Grid 

Grid displays multiple I/O source data in text for monitoring. 

Whenever data is updated in Run status, the color of Time column inverts. 

 

Grid column is editable. Right-click the head of grid, ‘Select Column’ dialog box appears. You 
can check the desired item to show.  

 

If you did not check ‘Display When Updated’ from the pop-up menu (see below), the color does 
not invert upon update. If you selected ‘Reset Min./Max.’ in the pop-up menu, Min and Max 
columns are reset and shows Min/Max values from that point on. 

 



  3 Getting Started 

©  Copyright Reserved Autonics Co., Ltd.  79 

If a parameter value causes an alarm (refer to the manual of the device), it flashes as below. 

  

 

 

In case of ARM Series, when Input IO or Output IO is added, the output by bit is available.  

 

Double-click the data (number) and you can edit the data and control it.  
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3.7.1.2 Multi panel 

It displays I/O source data as Flash type. Multi Panel Viewer can display several I/O source in a 
screen.. If alarm of parameter value occurs among data (refer to the manual of the device) and it 
flahses in the set alarm color.  

 

You can change align mode, color, update interval, etc. at Property.  

  

 Align mode: Set the align mode for several I/O source. It supports horizontal, vertical, 

horizontal grid align, vertical grid align. The below is the vertical grid align (grid: 3).  

 

  



  3 Getting Started 

©  Copyright Reserved Autonics Co., Ltd.  81 

 User Alam Settings: Sets user alam option to each Tag 

 

※The other settings are same as Panel graph. Refer to the ‘오류! 참조 원본을 찾을 수 

없습니다. 오류! 참조 원본을 찾을 수 없습니다.’.  
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3.7.1.3 Panel  

Panel displays I/O source data in Flash. A Panel can display only one I/O source. If a parameter 
value causes an alarm (refer to the manual of the device), it flashes as the set alarm color. 

 

Select Panel on the runtime screen in the project window to modify properties (such as color, 
update interval) in the Property window. 

    

Config section in the Property window contains the following items: 

 Display Mode: You can select Normal or Vector.  

Normal Vector 

  

 Update Interval: Panel update interval. 

 View Input I/O: Show/hide settings of the I/O source list. 

 Bottom Color: Background color of the panel. 

 Alarm Color: Invert color when an alarm is issued. 

Normal View Text Font section in the Property window contains the following items: 

 Unit Font: Unit font setting for normal view of display mode.  

 Value Font: Value font setting for normal view of display mode.  
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3.7.1.4 Line Graph 

Line Graph displays multiple I/O source data as a graph for monitoring. 

At the bottom is added I/O source list. Use the checkbox of  to show/hide the graph. 

 

To change the color by each I/O source, double-click the color front of device. 
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(1) Save image 

Save Image feature saves the current graph screen as an image. Save Image dialog 
appears when Save Image button is clicked. Images can be saved in ‘*.bmp’, or ‘*.wmf’ 
format. 

 
 Save To File: Saves in Bitmap (*.bmp) or Windows metafile (*.wmf).  

 Save To Clipboard (Bitmap): To use this image directly for other application program, 
saves in Bitmap (*.bmp) file to clipboard.  

 Save To Clipboard (MetaFile): To use this image file directly for other application 
program, saves in MetaFile (*.wmf) to clipboard.  

 Save CSV: Saves in CSV file(*.csv).  
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(2) Graph settings 

 Graph Settings tab 

Graph Settings allows you to change the general Graph environment. 

 
 

No Item Description 

1 Axis Settings Sets time (Hours, Min and Sec). 

2 Time Format Sets time expression for the Time Axis (X Axis) 

3 View Point 
Shows data point when selected (hides data point when not 
selected). 

4 Point Type Sets point type. 

5 Line Width Sets thickness of the graph line. 

6 Point Sets point size. 

7 View Data 
Shows data value when selected (hides data value when not 
selected). 

8 Digital Axis (%) Sets digital axis as a percentage. 

9 Line 
Sets displaying or not upper limit, reference, lower limit line. 
Sets Y value, color, width and line color of upper limit, reference, 
lower limit line. 
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 Y Axis Settings tab 

Set Y axis direction and range of each tag.  

 

No Item Description 

1 
Left/Right Y 
Axis 
Setting 

Sets the left/right Y axis auto scale, max/min range, and unit of the 
selected tag. Sets the inversion of Y axis.  

2 Tag List 
Shows s list of tag added at the graph.  
Selects the tag to be appeared as Y axis.  

3 
Left/Right Y 
Axis 

Sets the Y axis type (left/right) of the selected tag.  
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 Tool Config tab 

You can set the color band to recognize and emphasize the desired range.  

 

No Item Description 

1 Add/Delete/Delete all Adds/Deletes/Deletes all color band.  

2 Band list Displays the added color bands list.  

3 Band name Sets color band name.  

4 Band standard Sets Y axis (left/right) of color band standard.  

5 Start/End range Sets color band’s start/end range.  

6 Transparent Sets color band transparent.  

7 Color Sets color band color.  
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 Graph Theme 

You can set the graph theme (text color, grid color, background color).  

 

No Item Description 

1 Graph theme 

Selects graph theme.  

- Black 

 
- White 

 

2 Data text/Text/Grid/ 
Grid bottom/Bottom 

According to the set graph theme, sets colors of data 
text/ text/grid/grid bottom/bottom separately.  
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(3) List 

List displays or hides I/O source list items at the bottom of the graph.  
Clicking the List button toggles item display on and off. 
 List ON 

 

 List OFF 
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(4) Zoom 

Zoom controls Zoom In/Zoom Out of the graph. 

 
 Zoom 

① Zoom In 

 
On the graph, hold left mouse button and drag to lower right-hand corner to enlarge the 
selected area. 

② Zoom Out 

 
On the graph, hold left mouse button and drag to upper left-hand corner to return to 
default scale. 

③ Change X/Y Axis 

 
On the graph, hold right mouse button and drag to change positions of X/Y axes. If the 
graph is enlarged or X/Y axes positions have changed, X axis does not automatically 
move when data has updated. 
The program preserves user-changed graph scale and axes positions. It considers this as 
graph analysis mode. 

 Mouse wheel functions 

Operation Function 
Ctrl + mouse wheel up Increases X axis 

Ctrl + mouse wheel down Decreases X axis 

Shift + mouse wheel up Increases Y axis 

Shift + mouse wheel down Decreases Y axis 

Mouse wheel Increases/decreases X/Y axes at the same time. 
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 Data Analysis Mode 

Shows X axis (Time) and Y axis values of the mouse position on the graph. 

 

 Data Display Mode 

Displays all data values of the mouse position on the graph. 
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If any parameter value causes an alarm (refer to the manual of the device), it flashes 

as below. 
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3.7.1.5 Bar Graph 

Bar Graph displays multiple I/O source data as a bar graph for monitoring. 

At the bottom is added I/O source list. Use the checkbox of  to show/hide the graph. 

 

To change the color by each I/O source, double-click the color front of device. 
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(1) Save image 

Save Image feature saves the current graph screen as an image. Save Image dialog 
appears when Save Image button is clicked. Images can be saved in ‘*.bmp’, or ‘*.wmf’ 
format. 

  
 Save To File: Saves in Bitmap (*.bmp) or Windows metafile (*.wmf).  

 Save To Clipboard (Bitmap): To use this image directly for other application program, 
saves in Bitmap (*.bmp) file to clipboard.  

 Save To Clipboard (MetaFile): To use this image file directly for other application 
program, saves in MetaFile (*.wmf) to clipboard.  

(2) Graph settings 

Graph Settings allows you to change the general Graph environment. 

 
 

No Item Description 
1 Axis Set Sets the range of Min. and Max. values of the X/Y axes. 

2 3D View Sets the display status of the bar. 

3 Bar Style Sets the horizental and vertical styles of the bar. 
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(3) List 

List displays or hides the I/O source list at the bottom of the graph. Clicking the List button 
toggles item display on and off. 
 List ON 

 

 List OFF 
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3.7.1.6 Color Map Graph 

Color Map Graph displays multiple I/O source data as a color map graph for monitoring. 

At the bottom is added I/O source list. Use the checkbox of  to show/hide the graph. 

 

(1) Save image 

Save Image feature saves the current graph screen as an image. Save Image dialog 
appears when Save Image button is clicked. Images can be saved in ‘*.bmp’, or ‘*.wmf’ 
format. 

 
 Save To File: Saves in Bitmap (*.bmp) or Windows metafile (*.wmf).  

 Save To Clipboard (Bitmap): To use this image directly for other application program, 
saves in Bitmap (*.bmp) file to clipboard.  

 Save To Clipboard (MetaFile): To use this image file directly for other application 
program, saves in MetaFile (*.wmf) to clipboard.  
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(2) Graph settings 

 
 

No Item Description 

1 Graph Type 

 Normal 

 
 

 Polar 
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No Item Description 
2 X/ Y Axes set Sets max./min. value of X/Y axes range.  

3 Circle size Sets displayed circle size.  

4 List 
Shows s list of tag added at the graph. 
Double-click an item to set X,Y coordinate (Normal) or angle and 
distance (Polar Bar) depending on graph type setting.  

5 Color Map 
Sets color map.  
Color map supports HSV, JET, HOT, COOL, and GRAY mode.  

(3) List 

List displays or hides the I/O source list at the bottom of the graph. Clicking the List button 
toggles item display on and off.  
 List ON 

 

 List OFF 
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3.7.1.7 Gauge Graph 

A Gauge Graph can display only one I/O source. 

 

(1) Save image 

 
 Save To File: Saves in Bitmap (*.bmp) or Windows metafile (*.wmf).  

 Save To Clipboard (Bitmap): To use this image directly for other application program, 
saves in Bitmap (*.bmp) file to clipboard.  

 Save To Clipboard (MetaFile): To use this image file directly for other application 
program, saves in MetaFile (*.wmf) to clipboard.  
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(2) Graph settings 

 
 

No Item Description 

1 Gauge Type 

Sets gauge graph type.  

 Circle Guage 

 
 Horizental Liner 
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No Item Description 

 Vertical Linear 

 
 Numeric Gauge 

 
 LED Gauge 

 

2 
Minimum, 
Maximum, 
Label Interval 

Sets minimum/maximum value and label interval displayed on 
graph.  

3 TagName Visible Sets display and color option of tagname  

4 
Green/Red Line 
Visible 

Sets display option of green/red line in graph.  

5 
Green/Red Line 
Setting 

Sets start/end value of green/red line.  
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3.7.1.8 Histogram graph 

It devides and displays data by the set update interval and the number of devision.  
You can specify the update interval, upper/lower limit and the number of devision at Property.  

 

(1) Save image 

Save Image feature saves the current graph screen as an image. Save Image dialog 
appears when Save Image button is clicked. Images can be saved in ‘*.bmp’, or ‘*.wmf’ 
format. 

 
 
 Save To File: Saves in Bitmap (*.bmp) or Windows metafile (*.wmf).  

 Save To Clipboard (Bitmap): To use this image directly for other application program, 
saves in Bitmap (*.bmp) file to clipboard.  

 Save To Clipboard (MetaFile): To use this image file directly for other application 
program, saves in MetaFile (*.wmf) to clipboard.  
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(2) List 

List displays or hides the I/O source list at the bottom of the graph. Clicking the List button 
toggles item display on and off. 
 List ON 

 

 List OFF 
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3.7.2 Alarm 

3.7.2.1 Alarm History Grid 

Alarm History Grid displays alarm data of I/O source in text for monitoring. 

Whenever an alarm occurs in Run status, the alarm list is updated directly.  
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3.8 Connection 

All necessary settings to connect a device has completed as following image. 

   

 

Click the ‘Connect’ button on the toolbar and check the connection status in My System. If the 
connection is successful, Status displays ‘Connected’. 

To edit a parameter of a connected unit in DAQMaster, you should load parameters of the 
connected unit. 

Select TK4 Unit 1 in My System and then right-click it to execute the ‘Read All Parameters’. 
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When the reading is completed, the Property window displays the parameters. Parameter 
change is also available. 

  

If you only want to monitor paramiter without editing, click ‘Run’ button on the toolbar. 

When parameter values are changed in the Property window, changed values are immediately 
applied through communication with the device. While requesting a parameter value change, all 
property values are displayed in gray (not modifiable). They are restored to the original color, 
when the changing is over. 

To apply the changed value, change the value and press Enter (for edit type), or select an item 
with the mouse or the Alt + arrow keys, and press enter (for list type). 

If a unit related item in a parameter is changed, all unit values of the related parameter will be 
changed. If a range related item is changed, this range will be applied to all parameter items. 

If an out-of-range value is entered in a property with a range of value, the input is ignored and 
the value is restored to original. The range is displayed at the bottom of the Property box.  

A parameter with a designated input format is only editable in the specified format. 

Values of parameters in ‘Disable’ status are not displayed and the names are grayed out. In 
Reading mode, names and values of parameters are grayed out. 

The language of the parameters does not change (regardless of the language selected when 
installing the program). 
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3.9 Running the Program 

Below is an image of the program in progress. 

  

If you changed the layout from ‘Default’ to ‘Runtime’ on the toolbar (View > Layout), the 
monitoring screen displays as below. 
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Setting a reading repetition of the unit 

Under General box in Propetry window of connected units, ‘DAQ Repeat Interval’ sets an interval 
of I/O source reading repetition in ‘Run’ status.. The default value is 1000 ms. 

If four I/O sources are added to DAQ List, the program recieves data of four I/O sources from 
connected units and another four after 1000 ms passed, as shown in the diagram below. When 
the number of I/O do not exceed the Repeat Interval value(1000 ms), the program brings data 
on the designated cycle. 

 

When a large number of I/O sources are added, data reading cycle may exceed the defined 
Repeat Interval, as shown in the image below.  

 

In this case, the program change the preset Repeat Interval value to the minimum interval.. 

As a result, if actual I/O data reading time exceeds the set Repeat Interval value(time), the 
program and the units communicate on the minimum time interval required to read all I/O 
sources. 

If the environment requires a precise set value, add RS-232 port(s) and split the device 
connection. 
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3.10 Logging 

When the status is ‘Run’, the ‘Log’ button on the toolbar is activated. 

 

 

If you start logging, log start time and elapsed time are displayed on the right side. 

If you click Stop Logging, the Save As window appears. Files are saved in DAQ Data File (*.ddf) 
and CSV File (*.csv) format. 

 

DAQ Data Files (*.ddf) can be analyzed using tool. “Tool > Data Analysis in DAQMaster Program” 
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3.11 Saving Project 

You can save the project you were monitoring. 

Set values of device, RS-232 configuration, repeat interval, runtime screen are saved. Before 
saving, specify project properties as follows. 

1st Select Noname at the top of the project tree. 

  

2nd In the Property window, the project name is marked as Noname. Company name, 

worker, and description are empty. 
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Enter basic project information, such as company name, worker, and other 

descriptions as below.  

 

3rd Select “Project > File > Save” from main menu to save the project in the desired 

location. 
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3.12 Opening a Project 

Opens a saved project. 

There are two ways to open a project: ‘Open Project’ and ‘Open From List’. You can only open a 
project when communications are disconnected. 

3.12.1 Open Project 

Directly selecting a project file is the most common way to open a project file. 

 

3.12.2 Open Project List: 

This method opens a file from a list of frequently used projects. 

This is a convenient project file management system. Similar to the favorites menu of the 
Internet browser, you can add frequently used projects to the list. 

 

You can creat a parent folder in the Project List by clicking ‘Add Folder’ and manage saved 
project files under the parent folder. You can also change folder/file names as well as add or 
delete folders/files. 

Selecting a folder in the Project List activates Add Folder, Change Name, Add, and Delete 
menus. Selecting a project file in the Project List activates Add folder, Add and Delete menus. 

 

No Item Description 

1 Add Folder Adds a folder. 

2 Change Name Changes the name of folder. 

3 Add Adds a project file. Click Add opens Project List window.. 

4 Delete Removes selected folder or file. 
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3.13 Modbus Map Table Report 

This feature outputs ModBus map table of a device, which uses ModBus communications, as a 
report. 

Direct print out is available and you can save in a PDF File (*.pdf) or Html File (*.html) format. 

In the status that a device is added, right-click the device in My System and Select Print ModBus 
Map Table from the pop-up menu. 
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Below is a preview window. 

 

No Item Description 

1 Printer Setup 
Configures the printer to print.  
Printer setting options vary by a printer model. 

2 Print Prints the ModBus map table. 

3 Close Closes the print preview window. 
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4 Changing Program Language 

4.1 Change Language 

Changes the program language. Default language is the program installation language. 

 

Select “Tool > Language” from the main menu. Language option is applied immediately and the 
program is displyed in the selected language.  
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4.2 Modifying and Adding Languages 

DAQMaster program allows users to add and modify the language. Language files reside in 
‘lang’ folder in the installation folder. Its default format is XML. 

To modify language, open the language file in Notepad as below, modify and save. 

 

To add a language, copy and rename the existing language file. 

Change the title of language In <local>English</local> section in English. (highlighted with a 
square in the image below), change the English contents to your desired language and save. 

(For example, to change to Korean:  Change ‘File’ to ‘파일’.)  
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Since the default language file is in XML format, you can edit the file using XML Notepad (a 
freeware provided by Microsoft) as below. 
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5 Data Analysis 

With this program you can analyze monitored data files (*.ddf) through Grid or Graph screen. 

You can save monitored data files as a different file name. 

The screen below shows data analysis in progress. 
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5.1 Screen Layout 

DAQMaster data analysis screen is divided into sections as shown in the below screenshot and 
each section is composed of following items.  

 

No Item Description 
1 Menu Menus are displayed by category. Select a menu to display submenus. 

2 File List Shows a list of project files to analyze. 

3 
Analysis 
Window 

Shows items at the Analysis Space.  

4 DAQ List Shows I/O source list is saved in the data file. 

5 DB List Shows DB list.  

6 Analysis Space Space for displaying data grid, data graph, Alarm Grid.  

7 Data Grid Shows I/O data as grid data. 

8 Data Graph Shows I/O data as graph data. 

9 Alarm Grid Shows alarm data as grid data.  
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5.1.1 Menu 

5.1.1.1 Data File 

 

(1) Project 

 New: Initializes the opened Data file and the analysis screen. 

 Open: Opens the saved data file (*.dap). 

 Save: Saves the opened data file or anaylsis windows.  

 Save As: Saves the opened data file or anaylsis windows as other file name.  

(2) File 

 Open: Opens DAQMaster log file (*.ddf, *.krd, *.t5d). 

(3) Analysis Window 

You can add the items (grid, graph, alarm grid) for displaying Analysis Space. 

(4) Analysis Space 

You can add and delete a tap, or change the tap name at the Analysis Space.  

5.1.1.2 Database 

This menu is available only for DAQMaster Pro version. 

 

(1) Connect 

You can check the data of connected database.  

(2) DB Chart 

It displays database data as grid or graph via field setting, etc.  

5.1.1.3 View 

  

(1) View 

Opens file list, analysis window, DAQ List at Data Analysis. 

(2) Align Windows 

Aligns analysis windows. Select Tile Align, Horizontal Align, or Vertical Align according to the 
environment. 
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5.1.1.4 Help 

   

Information for DAQMaster data analysis program. 

5.1.2 File List 

Shows a list of opened Data Files (*.ddf). 

 

5.1.3 Analysis Window 

Shows items at the Analysis Space. 

 

5.1.4 DAQ List 

DAQ List shows I/O source list saved in the data file. 

I/O sources can be analyzed through the analysis screen. 
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5.1.5 Analysis Space 

(1) Grid 

Analyzes I/O data in grid. Drag the I/O source from the DAQ List and drop onto the data 
graph screen to analyze it.  

  

(2) Graph 

Analyzes I/O data in graph. Drag the I/O source from the DAQ List and drop onto the data 
graph screen to analyze it. 
Right-click to set the display setting of graph (tag, view point, Y Auto scale).   
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(3) Alarm Grid 

Analyzes alarm data in grid. Drag the alarm source from the DAQ List and drop onto the 
data graph screen to analyze it. 

 

(4) Analysis Spread 

This function is only for KRN1000. 
Analyzes tag values in spread. Displays data with in designated range, which is set by users. 
 
 

5.2 Analyzing Data 

5.2.1 Opening Data Files 

Select “Data File > Project > Open” to open a data file. 
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5.2.2 Add Analysis Screen 

DAQ List contains I/O source list of the file. At ‘Data File > Analysis Window’, select the added 
Data Grid, Data Graph, Alarm Grid for Analysis Space.   

Select I/O source on the DAQ List screen, then drag and drop onto the Data Grid, Data Graph, 
Alarm Grid. 

 

 

The file displayed on the Data Grid screen and the Alarm Grid can be saved as a different file 
name in *.txt, *csv, *.html or *rtf formats. 
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You can use zoom with the mouse wheel feature on the data graph screen for analysis. 

In Save Image, You can save the currently shown graph screen as an image .  

 

You can set time axis, time format, graph line width, etc of the graph in Graph Settings.  
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5.2.3 Print 

Data Analysis program supports printing graph, grid, etc. 

 

Click the ‘Print’ and the ‘Preview’ dialog box appears.  
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6 DDE Server 

DAQMaster performs as a DDE(Dynamic Data Exchange) Server, allowing communication 
among programs in Microsoft Windows system. This DDE Server became DAQMaster uses 
shared memory. DAQMaster provide protocol or format of instructions and message to 
applications. 

External programs can exchange data of DAQMaster with each other through DDE Server. 

1st Click “Tool > DDE Server” in main menu to open DDE Server Settings dialog. 

 

2nd From DAQ List, double-click Tag to provide to DDE Client. 

(Service: DAQMaster, Topic: DAQ are set) 
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7 Edit ModBus Device 

You can add the any modbus device which are not supported at DAQMaster and set and monitor 
the property and I/O. This function is available only for DAQMaster Pro version. 

(1) Creating Device File 

1st Double-click ‘Tool’ of menu and Edit Modbus executes at DAQ Space. 

 

 

2nd At Modbus Device File Settings, you can create new device file (*.udv) or load the 

saved user device file (*.udv).  

Enter vender name, product name, description, etc. and click ‘Save’ or ‘Save As’ to 

save the file.  
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3rd ‘Save’ or ‘Save As’ dialog box appears. Enter file name. The save file name is 

displayed at File Name of Modbus Device File Settings  

4th Refresh Support Device List and check the newly added device.  
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(2) Adding device properties and I/O  

6) Add One 

1st Click ‘Add’ at Properties and I/O List’ of Edit Modbus and ‘Add’ dialog box appears. 

Select ‘Add One’ and click ‘OK’. 

 

2nd Set save type and the desired contents at Properties and I/O Edit of Edit Modbus.  

In case of add one, set the one save type among category, properties, or I/O.  
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3rd When save type is ‘category’,  

Set the category name. Click ‘Save’ and the category is added at the properties list.  

 

4th When save type is ‘properties’, 

Set name, read/write type, address, size, value type, etc of properties. Click ‘Save’ 

and the properties is added at the properties list. 
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5th When save type is ‘I/O’, 

Set name, read/write type, address, size, value type, etc of I/O. Click ‘Save’ and the 

properties is added at the I/O list. 

 

6th To edit the properties and I/O, click the desired one at Properties or I/O List. At the 

Properties and I/O Edit, the contents are displayed. After the edit, click ‘Save’.  
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7) Auto Add Multiple,  

1st Click ‘Add’ at Properties and I/O List’ of Edit Modbus and ‘Add’ dialog box appears. 

Select ‘Auto Add Multiple’ and below menu is activated.  

 

2nd Select save type at ‘Add’ dialog box.  

In case of auto add multiple, set tye one save type between properties, or I/O. 
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3rd Set name, read/write type, address, size, value type, etc of properties or I/O for auto 

add multiple. 

Set start number and add number to add multiple properties or I/O.  

For example, property name: AL, Start number: 1, Add number: 5, total 5 properties 

are automatically added as AL1 to AL5 name.  

 

Set user group which helps to reduce time for reading/writing data for the same group. 

4th To edit the properties and I/O, click the desired one at Properties or I/O List. At the 

Properties and I/O Edit, the contents are displayed. After the edit, click ‘Save’. 
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8 TCP/IP Server 

DAQMaster performs as TCP/IP Server and exchanges monitoring data with DAQMaster Client 
in JSON format. Network data can be displayed in server, allowing data monitering. 

1st Click “Tool > TCP/IP Server” in main menu to operate DAQMaster Server. Pop-up 

message saying ‘Run DAQMaster Server’ appears at the corner of the screen. 

 

2nd Icon  is generated on the Windows taskbar. When you double-click this icon, 

DAQMaster TCP/IP Server setting dialog pops up. 

TCP/IP address (highlighteded with red box) is displayed automatically. In order to 

connect Client, this addess is need to be entered. 

 

3rd Click ‘Settings’ to set TCP/IP Port. (Default option: 5050) 

4th In ‘User Management’ tap, you can manage a list of client users accessible to TCP/IP 

Server by adding, deleting, edting user ID and password. 

In ‘Stay Login’ tap, you can check log-in/log-out time and detailed connection 

information of listed users. 

In ‘Events’ tap, you can see every events releated to logged communication. 
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9 Script Editor 

With Script Editor, you can edit script of Script Decive. 

Click “Tool > Script Editor” in the main menu to execute ‘Script Device Editor’ 

 

Supported scripting language is C, JS, Basic, and PAS. 

Script Device Editor provides script reference. 
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‘Check’ in Compile checks whether scripting language has error or not. 

When errors are detected in the scripting language, output box pops up at the bottom of the 
screen and shows details about errors. (double-clicking erroneous item leads you to the point) 

 

If checking is over without error, modified script language is loaded automatically and ready to 
use when running DAQMaster. 
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10 Special Features 

This chapter describes special features when connecting the device and DAQMaster. 
Each special feature is different by the device, refer to the below descriptions of each device.  

10.1 TK Series(high accuracy standard PID control 

temperature controller) 

TF3 Series (refrigeration temperature controller) 

KPN Series (high performance and high accuracy 

process controller) 

Save parameter values, copy parameters, parmaeter mask and user parameter group is 
available by DAQMaster. (Following explanation is based on TK) 

(1) Save parameter values 

When several same model units cannot be connected to DAQMaster at once and parameter 
copy is not available, you can save the setting of the device as a file and utlize the file at a 
later.  

1st Connect the TK device which parameters are saved.  

2nd Click ‘Read All Parameters’ of the unit device which parameters are saved or ‘Read 

All Unit Parameters’ of TK at My System.  

  

3rd Select TK at My System and right-click to select ‘Copy Parameters’ and Parameter 

Copy dialog appears.  
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4th Right-click the unit which parameters are saved and select ‘Parameter Select’. The 

parameter values of the unit is loaded at the right side of the dialog.  

 

5th Click ‘Save’ and it saves parameters in *.prx file.  
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(2) Copy parameters 

To connect the several same model units at once, you can copy the parameters. You can 
copy the saved parameter file or the parameter settings of the dedicated device(standard 
unit) to the other devices(target units).  
 To copy the saved parameter file, 

1st Same orders 1st to 3rd of the Save parameter values.  

2nd Check the units to be copied at the check box of the left side of the dialog.  

3rd Click ‘Open’ and select the parameter file and it loads at the right side of the dialog.  
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4th Click ‘Copy’ and copy is progressing. ‘the Process of Copying data’ text appears at 

the right side of the dialog.  

 

5th After completing copy, ‘Copy Complete!’ dialog box appears. Click ‘OK’ and copy is 

finish.  

 To copy the parameter settings of the dedicated device(standard unit) to the other 
devices(target units), 

1st Same orders 1st to 3rd of the Save parameter values. 

2nd Check the units to be copying (standard unit) and to be copied (target unit) at the 

check box of the left side of the dialog. 

3rd Right-click the unit to be copying(standard unit) and select ‘Parameter Select’. The 

parameter values of the unit is loaded at the right side of the dialog. 
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4th Click ‘Copy’ and copy is progressing. ‘the Process of Copying data’ text appears at 

the right side of the dialog.  

 

5th After completing copy, ‘Copy Complete!’ dialog box appears. Click ‘OK’ and copy is 

finish. 
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(3) Parameter mask  

This feature is able to hide unnecessary parameters to user environment or less frequenctly 
used parameters in parameter group. 
Masked parameters are not only displayed. The set values of masked parameters are 
applied.

 
 

No Item Description 

① 
Parameter mask 
selection 

Select the to-be masked parameters.  
Right-click the to-be masked parameters and they turn gray. 

② Download Applies the set masked parameters to the device.  

③ Save Saves the set masked parameters as a mask information file.  

④ Open Opens the saved mask information file.  

⑤ 
Initialize factory 
default 

Clears the set for the masked parameters.  
Download this setting to apply it to the device.  

⑥ Close Closes the Parameter Mask Settings dialog.  

⑦ Device information Displays device name, unit address, model name, and version.  
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Example of masking alarm, SV setting parameters of parameter 1 group, input type, unit of 
parameter 3 group, and all of parameter 4 group.  
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(4) User parameter group [PARU] 

This feature is able to set the frequently used paramters to the user paramter group. You 
can quickly and easily set parameter settings. 
User parameter group can have up to 30 parameters.  

 
 

No Item Description 

① 
User parameter 
group 

Displays the selected parameters as user group parameter 
Double-click the parameters for the user group, and these parameters 
turn gray.  
To delete the parameters at the user group, double-click the 
parameters.  

② 
User group 
selection 

- All initialize: Initializes the set user group.  

- ↑,↓: Changes the selected parameter order up/down.  

③ Download Applies the set user group to the device. 

④ Save Saves the set user group as a user group information file. 

⑤ Open Opens the saved user group file.  

⑥ 
Initialize factory 
default 

Clears the set for the user group. 
Download this setting to apply it to the device. 

⑦ Close Closes the User Group Settings dialog.  

⑧ 
Device 
information 

Displays device name, unit address, model name, and version. 
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Example of the set user group with SV setting, control output RUN/STOP, alarm outptu 1 
low/high-limit, SV-0/1/2/3 set value, manual reset, input correction, alarm output 1 
mode/option/hysteresis/contact type/ON delay time/OFF delay time parameters. 
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10.2 DS/DA-□T(Intelligent Display Unit) 

DS/DA displays I/O source value, unit, and user set value by DAQMaster. 

Connect DAQMaster and DS, DA(RS485 input type) and click ‘…’ button located on the right of 
Setting at Config in the Property window. A display unit screen is open at DAQ Workspace.  

 

 

Double-click a moniring screen of a display unit screen at DAQ Workspace and Setting dialog 
appears.  
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No. Item Description 

① NUM 
Set the number of display units.  
Set range is 1 to 24.  

② Line Mode Displays the added sources of list at the connected display units in a line. 

③ Overlap Mode 
Displays the added sources of list at the connected display units by 
overlapping at the set interval time. 

④ Overlap Interval Activated for overlap mode. Set the interval time for overlap display. 

⑤ Display parts 

Displays the connected display units and sources in the set color.  
Right-click this part to select the segment.  

 
When selecting unit segment, Unit Type dialog box appears to select the 
unit display mode.  
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⑥ Add Date/Time 

Select one of date and time information types.  

 

⑦ Add User Display 
Add the desired characters.  
Enter the characters at Source of DPU Data.  

⑧ Del Delete the added source of list.  

⑨ List 

Displays the added I/O sources.  
Add I/O sources by dragging them at DAQ list.  

Press ‘Ctrl+↑ or ↓’ to change the order of sources.   

⑩ Data 
 

 Display type 

- IO Source: Displays the value of the source.  

- IO TagName: Displays the name of the source.  

- IO Unit: Displays the unit of the source.  

 Text Align: Sets the alignment at the display units.  

 Source: Displays the name of I/O source and it is editable.  

 Num: Sets the desired number of display units.  

 Save: Saves the settings.  

⑪ 
7 Segment Data 
Type 

Sets the display type for H, I, J, K, N, O, T, X characters.  

⑫ 
DPU Update 
Interval 

Sets the update interval for data value.  
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⑬ Color 

Sets the displayed color at run time screen.  

 

 

Example of adding two date/time sources, overlap mode and 2000ms of overlap interval.    

 

It displays 2012-04-13 for 2 sec.(2000ms) at first then displays 03:20:06 PM for 2 sec. alternately.  
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10.3 SCM-WF48 (Wi-Fi/RS485·USB Communication Converter) 

Communication setting of SCM-WF48 is editable with DAQMaster. 
Connect DAQMaster and SCM-WF48 after setting communication mode to USB with USB/485 
communication mode switch on the side of the SCM-WF48 device. 

Double-click SCM-WF48 in My System to open SCM-WF48 Config tap in DAQ Space. 

 

(1) Connecting device 

You can connect SCM-WF48 to DAQMaster in manual mode or auto mode. 
1) Manual connection

 

Enter the port, baudrate, byte size, parity, stop bit values in the upper side of the 
SCM-WF48 Config tap equal to SCM-WF48 device and click ‘Connect’. 
Followings are default values of SCM-WF48. 

Baudrate 9600 

Byte Size 8 

Parity None 

Stop Bit 1 

2) Auto connection 
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Click ‘Auto Search’ to open ‘Auto Search’ dialog. 
If you select items to search and click ‘Search’ button, DAQMaster displays 
accessible SCM-WF48. 
When PC is connected with over 2 SCM-WF48 devices, DAQMaster is automatically 
connected with first SCM-WF48 in numerical order of port number. 

(2) Setting communication mode 

Select communication mode of SCM-WF48 from AP mode and Station mode. 

 
1) AP mode 

 

SCM-WF48 performs as AP (access point). 
PC, smart phone, PLC are connected directly with SCM-WF48 using Wi-Fi to 
communicate with other devices which are connected to SCM-WF48 with RS485 
wired connection. 

1st Click ‘AP Mode’ to operate AP mode setup wizard. 
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2nd Set Wi-Fi generation. 

  

 AP name: Sets displaying name. 
Default is SCM-WF48AP. 

 Channel: Sets Wi-Fi frequency. (setting range: Auto, 1~14) 
If the number of channel is same or next to each other with another 
wirelessly connectied devices, communication interference occurs and 
makes communication status unstable. 

 Static IP: Sets IP, Mask, Gateway as follows. 
Please check network environment ahead of setting. 

IP 192.168.1.1 

Mask 255.255.255.0 

Gateway 192.168.1.1 
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3rd Set Wi-Fi authentication. 

  
Followings are types of authentication. 

Type Description 

Auto 

Selects mode of authentication automatically. 

Passphrase is required for connection. 

If you enter passphrase at the first time, DAQMaster connects 
automatically without passphrase. 

Open Selecting SSID connects AP, without passphrase. 

PWA 

WEP 

Encrypts connection and communication. 

In order to strengthen security, PWA mode is recommended. 

Passphrase is required for connection. 

Order of security safety: WPA2TKIP > WPA2AES > WPAAES, 
WPA2 > WPA > WEP 

WPA 

WPA2 

WPAAES 

WPA2AES 

WPA2TKIP 
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4th Set Wi-Fi protocol. 

 

 Protocol: Select Wi-Fi protocol from TCP, UDP. 

 Mode: ‘AP mode’ only supports Server mode. 

 Port: A set of server and client has set in same port value. 
(In Modbus communication, 502 port is used in general) 

5th Set UART. 

 

Enter the Baudrate, Byte Size, Parity, Stop Bit values equal to the device which is 

connected to SCM-WF48 device with RS485 or USB and click ‘Write’. 
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6th On the SCM-WF48 Config tap, setting values are displayed on the left side and 
progress for connection is shown on the right side. 

When applying setting values is completed, message saying ‘Write OK!’ pops up. 

 

7th AP mode setting is finished. 

Please reboot SCM-WF48 device in order to apply setting values to the device. 
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2) Station mode 

 

SCM-WF48 is linked to another AP. 
Wireless router and SCM-WF48 is connected using Wi-Fi therefore PC, smart phone, 
PLC connected to wireless router can communicate with other devices which are 
connected to SCM-WF48 with RS485 wired connection. 

1st Click ‘Station Mode’ to operate Station mode setup wizard. 

2nd Set Wi-Fi generation. 

 

 AP name: Sets displaying name. 
Default is SCM-WF48AP. 

 AP Scan: Scans AP.  
When scanning AP, it may be necessary to repeat again.  

 MAC select/address: Check the ‘MAC select’ and you can enter MAC address.  
When the same SSIDs exist, enter the MAC address and connect the desired 
SSID.  

 Channel: Sets Wi-Fi frequency. (setting range: Auto, 1 to 14) 
If the number of channel is same or next to each other with another wirelessly 
connectied devices, communication interference occurs and makes 
communication status unstable. 

 IP: Selects IP from DHCP and Static IP. 

DHIP: DAQMaster sets IP automatically. 

Static IP: User sets IP manually. 
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 Static IP: Sets IP, Mask, Gateway as follows. 
Please check network environment ahead of setting. 

IP 192.168.1.1 

Mask 255.255.255.0 

Gateway 192.168.1.1 

 

3rd Set Wi-Fi authentication. 

 
Followings are types of authentication. 

Type Description 

Auto 

Selects mode of authentication automatically. 

Passphrase is required for connection. 

If you enter passphrase at the first time, DAQMaster connects 
automatically without passphrase. 

Open Selecting SSID connects AP, without passphrase. 

PWA 

WEP 

Encrypts connection and communication. 

In order to strengthen security, PWA mode is recommended. 

Passphrase is required for connection. 

Order of security safety: WPA2TKIP > WPA2AES > WPAAES, 
WPA2 > WPA > WEP 

WPA 

WPA2 

WPAAES 

WPA2AES 

WPA2TKIP 
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4th Set Wi-Fi protocol. 

 

 Protocol: Select Wi-Fi protocol from TCP, UDP. 

 Mode: Select Mode from Server and Client. 
Server: SCM-WF48 operates as server. 
Client: SCM-WF48 operates as client. Connecting information of server is 
required. 

 Server IP: Enter server IP. 

 Port: A set of server and client has set in same port value. 
(In Modbus communication, 502 port is used in general) 

5th The other settings are same as AP mode. Refer to the ‘1) AP mode’. 

3) Advanced settings 

Set network communication at once without setup wizard. 

You can save/ load/save as the communication settings.  
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Notes for SCM-WF48 communication setting 

 Single Wi-Fi network needs at least one AP. 

 Single network consisting of wire and wireless connection needs at least one DHCP server. 

 At least one set of server and client is necessary. 
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(3) Utility 

‘UART Settings’, ‘Reset Factory Default’, ‘Profile’ allows you to check or edit the setting 

value. 

 
1) UART Settings 

You can check or edit VCP(USB), RS-485 communication setting values. 

 
2) Reset Factory Default 

Initializes Baudrate, Byte Size, Parity, Stop Bit of SCM-WF48 to its factory default 
settings. 
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3) Profile 

Displays Wi-Fi setting information of SCM-WF48. 

 
 
 

(4) Firmware version upgrade 

After connecting SCM-WF48, you can check the firmware version and upgrade it at top-right 
of SCM-WF48 Config tab. (your computer should have wireless lan and Internet connection 
is required.) 

 

1st Click the  icon.  

2nd The dialog for firmware version upgrade appears.  

Click the ‘OK’ button.  
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3rd The ‘Firmware Upgrade’ dialog box appears.  

 

Wireless network connection of PC sets as OTA and click ‘OK’.  

4th It connects to ‘OTA Firmware Update’. 

 

Add the SCM-WF48 firmware which is downloaded at Autonics web site.  

Click the ‘Upload’ button.  

5th Firmware upgrade is completed.  
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10.4 KRN50 (50mm compact hybrid recorder) 

The following are special features for KRN50 while in communication with DAQMaster. 

(1) Accessing Record Backup Data 

To get the recorded data, click ‘...’ button located on the right of Record Backup in the 
Property window. 

 
To read memory information, the device status must be Connected and not Run.  
There are also cases in which you cannot read from memory depending on KRN50 
parameter setting. (Refer to ‘KRN50 user manual’.) 
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Once all conditions are met and ready to get memory data, follow the steps below: 

1st Run [Memory Information] in KRN50 Record Memory Data window. It gets the 

information from currently saved memory. 

2nd Set [Uploaded Data Size]. 

3rd Run [Upload Data]. 

4th You can cancel the operation while data is being uploaded. When data reading is 

complete, OK button is enabled. 

5th If you click OK, recorded data will be shown in two screens - the Grid and the Graph. 
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(2) Downloading User Images 

User Image allows you to download images to KRN50 and change logo, unit and boot 
images.  
You can also reset images back to the original status. This is also a self protocol, so cannot 
download images during Run. 

1) Download logo 

You can change the company logo image on contents that are printed on recording 
paper. 
Logo image should be 384 X 80 pixel of bitmap file. 

 

2) Download Units 

There are 0-9 user units. 

The download procedure is: select a unit list → select a destination to save → 

double-click a unit image to add the image → download. 
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3) Download boot images 

The boot image (logo image) appears on LCD upon initial power supply to KRN50. 

You can change booting logo image which displays when KRN50 is power ON.  
The image should be 128 X 32 pixel of bitmap file. 
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10.5 KRN100 (100mm hybrid recorder) 

The following are special features for KRN100 while in communication with DAQMaster. 

(1) Accessing Record Backup Data 

It is available to access saved backup data of KRN100 and to analyze backup data by data 
analysis feature.  

To get the recorded data, click ‘...’ button located on the right of Record Backup from User 

Memory in the Property window. 

 

According to the USER INFORMATION SETUP of KRN100,  it cannot read the 

memory. (Refer to the user manual for KRN100.) 

1st Designate the folder for record backup data to be saved.  
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2nd Select the record backup data to download. Click the right mouse button and select 

‘Download Log File’.  

Double click the backup data and it enters to data analysis.  

 

3rd After completing download to the desginated folder, the below message appears.  
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(2) Downloading User Images 

You can add user unit and boot images of KRN100.  
4) Download units 

There are 0-9 user units.  
The download procedure is selecting User Unit Position, double-click Small Unit, 
Middle Unit, Big Unit image, and selecting the image. After this, Download button is 
active.  

 

5) Download boot images  
The boot image (logo image) appears on LCD upon initial power supply to KRN100. 
You can change booting logo image which displays when KRN100 is power ON.  

The image should be 320×120 pixel of bitmap file. 
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10.6 KRN1000 (LCD touch screen paperless recorder) 

The following are special features for KRN1000 while in communication with DAQMaster. 

(1) Record Backup 

You can download backup data which is saved in KRN1000 internal memory from “Record 
Backup” section.  
Directory form is year, month, day. Click the relevant icon and check below list.  
To download backup file, click the file name with right mouse button and select "Download 
Log File" menu. 

 
Backup files are strucured as tree type directory at KRN1000 internal memory. You can 
easily fine and download the desired file. 
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10.7 ModBus Master 

Select ModBus Master of My System and click ‘…’ of property. ModBus Master dialog box opens. 

  

(1) ModBus Master Communication test 

Click ‘Communication Test’ and it executes communication test.  
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(2) CRC16 calculate 

This is calculating CRC16 of protocol.  
To calculate CRC16, enter Hex data to data and click ‘CRC16 Calculate’. It creates two 
CRC16 data.  
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10.8 Miscellaneous 

You can add or edit the miscellaneous devices which are not supported at DAQMaster. This 
function is available only for DAQMaster Pro version. 

 

10.8.1 Database 

1st Double-click ‘Database’ of Miscellaneous at Support Device List to add it at My 

System.  

(Enter ‘Database’ at search box.) 

 

2nd At My System, Database is added. Click ‘Add’ to add unit(s).  

    

 

 

 

3rd Click the added unit and Database property is displayed at Property window.  
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4th Click ‘...’ button of Settings and ‘Database Settings’ dialog box appears.  

 

You can set provider, server, port, user name, password, database at Database 

Settings dialog box.  

It is available for various database and supports I/O function.  

 

 

 

 

 

 

10.8.2 DDE Client 

1st Double-click ‘DDE Client’ of Miscellaneous at Support Device List to add it at My 

System. 

(Enter ‘DDE Client’ at search box.) 
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2nd At My System, DDE Client is added. Click ‘Add’ to add unit(s). 

 

3rd Click the added unit and DDE Client property is displayed at Property window. 
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4th Click ‘...’ button of Settings and ‘DDE Client Configuration-1’ dialog box appears. 

 

5th For connecting DDE Server, enter Service, Topic of DDE Server as as Service and 

topic of DDE Client Configuration-1. 

Below is for Test: DDE Server. 

 

When DDE Server Service: DDE Server, Topic: DAQMaster,  

Enter service of DDE Client Configuration-1 as ‘DDEserver’, and topic as 

‘DAQMaster’. 
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6th Click ‘Add’ at ‘DDE Client Configuration-1’ dialog box to add DDE Item. 

Test: DDE Server supports for items (DdeServerItem1 to 4). 

 

Item Description 

Item Name Enter DDE Server item name.  

Unit Set data unit. 

Description Enter description of the item.  

R/W 

R Reading is only available.  

W Writing is only available.  

R/W Reading/Writing is only available.  

Type Set data display method.  

Decimal Point  Set decimal point position 

List Displays item list.  

The below is when added two items. 

 

7th Check the added item at I/O List and it is available to be added at DAQ List.  
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8th At runtime screen, monitoring is available by various graph types.  
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10.8.3 OPC Client 

1st Double-click ‘OPC Client’ of Miscellaneous at Support Device List to add it at My 

System. 

(Enter ‘OPC Client’ at search box.) 

 

2nd At My System, OPC Client is added. Click ‘Add’ to add unit(s). 

 

3rd Click the added unit and OPC Client property is displayed at Property window. 
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4th Click ‘...’ button of Settings and ‘OPC client Configuration_1’ dialog box appears. 

 

5th Click ‘▼’ button at OPC Server to select the desired OPC server.  
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6th When selecting OPC Server, OPC server path is displayed as list.  

Double-click OPC server path or select OPC server path and click ‘→’ button, the 

path is added at I/O List.  

 

 

7th You can add or delete OPC server path by ‘Add, Delete, Delete All’ of upper menu of 

I/O List. 
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8th Check the added path at I/O List and and it is available to be added at DAQ List. 

  

  

9th At runtime screen, monitoring is available by various graph types. 
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10.8.4 WMI Manager 

1st Double-click ‘WMI Manager’ of Miscellaneous in Support Device List to add it to My 

System. (Enter ‘OPC Client’ at search box.) 

 

2nd Click ‘Add’ to add unit to WMI Manager in My System. 

 

3rd When you click a unit in My System, you can check properties of WMI Manager in the 

Property box. 

 

4th Click […] button in the Property box to open ‘WMI Configuration’ window. 
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5th Click ‘Connect’ to monitor local CPU load. When connecting is completed, items such 

as CPU Usage, Total Memory, Free Memory appears in the Query list. 

6th Double-click item to monitor in order to open setting dialog and click ‘OK’ in dialog to 

add in source list in the right side. You can edit the source list with ‘Delete’ and 

‘Delete All’ button. 

 

 

In User Query, you can perview a result in diverse WMI Query format. 

 

 



  10 Special Features 

©  Copyright Reserved Autonics Co., Ltd.  191 

 

7th Added query items to source list are registered automatically in I/O list. The items can 

be listed in DAQ list like another I/O source. 

 

8th You can moniter selected query items at the runtime screen in various kinds of graph 

style. 
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  10 Special Features 

©  Copyright Reserved Autonics Co., Ltd.  193 

 

 MWA-DAQU1-V2.7-1802US 


	1 DAQMaster Overview
	1.1 Overview
	1.2 Features
	1.3 DAQMaster Funtion Comparison Table by Version

	2 Installing the Program
	2.1 System Requirements
	2.2 Preparations
	2.2.1 Register License
	2.2.2 Installation Folder Structure
	2.2.3 Uninstalling the Program

	2.3 Start and Exit
	2.3.1 Start
	2.3.2 Exit

	2.4 DAQMaster Screen Layout
	2.4.1 Menu
	2.4.2 Support Device List (Docking Screen)
	2.4.3 Project
	2.4.4 I/O List (Docking Screen)
	2.4.5 My System
	2.4.6 DAQ List
	2.4.7 Message
	2.4.8 DAQ WorkSpace
	2.4.9 Property
	2.4.9.1 Project Properties
	2.4.9.2 My System Properties
	2.4.9.3 DAQ List Properties
	2.4.9.4 Runtime Properties


	2.5 Runtime Screen Library
	2.5.1 Data
	2.5.2 Alarm


	3 Getting Started
	3.1 Support Device List - Selecting a Device
	3.2 Setting RS-232, TCP/IP
	3.2.1 RS-232C
	3.2.2 TCP/IP

	3.3 Adding a Unit to My System
	3.4 Scan Unit
	3.5 Adding an I/O to the I/O List
	3.6 DAQ List
	3.7 Adding from DAQ List to Runtime Screen Library
	3.7.1  Data
	3.7.1.1 Grid
	3.7.1.2 Multi panel
	3.7.1.3 Panel
	3.7.1.4 Line Graph
	3.7.1.5 Bar Graph
	3.7.1.6 Color Map Graph
	3.7.1.7 Gauge Graph
	3.7.1.8 Histogram graph

	3.7.2 Alarm
	3.7.2.1 Alarm History Grid


	3.8 Connection
	3.9 Running the Program
	3.10 Logging
	3.11 Saving Project
	3.12 Opening a Project
	3.12.1 Open Project
	3.12.2 Open Project List:

	3.13 Modbus Map Table Report

	4 Changing Program Language
	4.1 Change Language
	4.2 Modifying and Adding Languages

	5 Data Analysis
	5.1 Screen Layout
	5.1.1 Menu
	5.1.1.1 Data File
	5.1.1.2 Database
	5.1.1.3 View
	5.1.1.4 Help

	5.1.2 File List
	5.1.3 Analysis Window
	5.1.4 DAQ List
	5.1.5 Analysis Space

	5.2 Analyzing Data
	5.2.1 Opening Data Files
	5.2.2 Add Analysis Screen
	5.2.3 Print


	6 DDE Server
	7 Edit ModBus Device
	8 TCP/IP Server
	9 Script Editor
	10 Special Features
	10.1 TK Series(high accuracy standard PID control temperature controller) TF3 Series (refrigeration temperature controller) KPN Series (high performance and high accuracy process controller)
	10.2 DS/DA-□T(Intelligent Display Unit)
	10.3 SCM-WF48 (Wi-Fi/RS485 USB Communication Converter)
	10.4  KRN50 (50mm compact hybrid recorder)
	10.5 KRN100 (100mm hybrid recorder)
	10.6 KRN1000 (LCD touch screen paperless recorder)
	10.7 ModBus Master
	10.8 Miscellaneous
	10.8.1 Database
	10.8.2 DDE Client
	10.8.3 OPC Client
	10.8.4 WMI Manager



